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Abstract

Originally there was an effort to harmonize a list of standards and specifications that was in use by the National Aeronautics and Space Administration (NASA) Earth Science community. These specifications included the Directory Interchange Format (DIF), Earth Observing System (EOS) Clearing House (ECHO) 10, and International Organization for Standardization (ISO) 19115-2. The result of the harmonization effort was the Unified Metadata Model (UMM). This document - the UMM-Common document - describes the compilation of elements that are shared among the UMM profiles which include: collections, granules, services, visualizations, variables, and documents. Implementers of Earth Science Data and Information System's (ESDIS) Common Metadata Repository (CMR), its clients, and data providers should reference this document and the UMM as a guide while implementing the system, its clients, or generating metadata. Links to more information about the standards and specifications used in this document can be found in the introduction's related document section.
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1 Introduction
Earth Observing System (EOS) Data and Information System (EOSDIS) generates, archives, and distributes enormous amounts of Earth Science data, which in turn are made available to the science community and the public at large. To aid in the search and discovery process, these data must be organized and cataloged. Accurate, complete, and consistent metadata are required for efficient accessibility.  To improve the quality and consistency among its metadata holdings, EOSDIS has developed a model describing metadata that it archives and maintains. This model documents elements that may be represented across various metadata standards and unifies them through core elements useful for discovery. This unified model, aptly named the Unified Metadata Model (UMM), was developed as part of the EOSDIS Metadata Architecture Studies (MAS) I and II conducted between 2012 and 2013. The UMM will be used by the CMR and will drive search and retrieval of metadata cataloged within that system.

 

This document describes common elements used in various UMM reference profiles, which include: collections, granules, services, visualizations, variables, and documents.

1.1 Purpose
This document provides information to the NASA Earth Science community. Distribution is unlimited.

1.2 Scope
This document is a supplemental document to the Collection Metadata Model. The version number for the model described in this document is 1.14.

1.3 Related Documentation
The latest versions of all documents below should be used. The latest ESDIS Project documents can be obtained from Universal Resource Locator (URL): https://ops1-cm.ems.eosdis.nasa.gov. ESDIS documents have a document number starting with either 423 or 505. Other documents are available for reference in the ESDIS project library website at: http://esdisfmp01.gsfc.nasa.gov/esdis_lib/default.php unless indicated otherwise.

1.3.1 Applicable Documents
The following documents are referenced within or are directly applicable, or contain policies or other directive matters that are binding upon the content of this document.

 

	Document Number
	Document Title

	N/A
	CMR Life Cycle

https://wiki.earthdata.nasa.gov/display/CMR/CMR+Documents

	N/A
	DIF 9

https://gcmd.nasa.gov/Aboutus/xml/dif/dif.xsd

https://gcmd.nasa.gov/add/difguide/index.html

	N/A
	DIF 10

https://gcmd.gsfc.nasa.gov/Aboutus/xml/dif/dif_v10.2.xsd

https://gcmd.gsfc.nasa.gov/DocumentBuilder/defaultDif10/guide/

index.html

	N/A
	ECHO 10

https://wiki.earthdata.nasa.gov/display/echo/Earth+Observing+

System+Clearing+House+-+ECHO

https://cdn.earthdata.nasa.gov/echo/

	N/A
	ISO 19115-2 (MENDS)

http://www.iso.org/iso/catalogue_detail.htm?csnumber=39229

https://cdn.earthdata.nasa.gov/iso/


1.3.2 Reference Documents
The following documents are not binding on the content but referenced herein and, amplify or clarify the information presented in this document.

 

	Document Number
	Document Title

	N/A
	Tag

http://en.wikipedia.org/wiki/Tag_%28metadata%29

	N/A
	XPath (https://en.wikipedia.org/wiki/XPath) is a language for addressing parts of an XML document, designed for use with XSLT.

	N/A
	MENDS

More information on the Base Metadata Requirements established by the MENDS group: https://wiki.earthdata.nasa.gov/display/NASAISO/NASA+Base+Metadata+Requirements


1.4 Impact
This document outlines common elements used in the Unified Metadata Model that are intended to be backward-compatible with existing NASA earth science metadata implementations. It will impact providers from NASA Distributed Active Archive Centers (DAAC[s]), CMR client developers, metadata catalog developers, and users.

1.5 Copyright Notice
The contents of this document are not protected by copyright in the United States and may be used without obtaining permission from NASA.

1.6 Feedback
Questions, comments and recommendations on the contents of this document should be directed to support@earthdata.nasa.gov.

1.7 Document Conventions
This document contains UMM common elements. These elements are used by the other UMM models and reference the element definitions defined in this document. The element definitions can contain the following components:

· Element Name: Provides the element name.

· Element Specification: Provides the sub-elements, cardinality of the sub-elements within (), any valid values within <>, applicable comments and notes within {}, and any other major factors that make up the element.

· Description: Provides background information on the purpose of the element and its intended use. Furthermore, any information about the element's current usage, recommendations for usage, or unresolved issues is also documented here. The term "resource" is also used mainly in the description section though it can be used elsewhere and it is meant to denote collections, granules, services, visualizations, variables, documents, etc.

· Profile Utilization: Lists which profiles use the specific element.

· Cardinality: Indicates the expectation of counts for this element, summarized in Table 1.

· Analysis: Gives an analysis of this element where needed.

· Mapping: Gives Extensible Markup Language (XML) Path Language (XPath) mappings for this element to the elements in other specifications. This can be considered as the "crosswalk" for this element. For a link to more information about XPaths please see the introduction's reference documents section.

· Examples: XML snippets from "cross-walked" data standards documenting sample values for the element. Whenever possible, a Uniform Resource Locator (URL) to the specific collection or service used for the metadata snippet, is provided.

 

With the exception of Element Name, each of the element's sections that are included are listed in bold to make it easier for the reader to distinguish between the element's section headings and the descriptions.

 

Table 1 below shows values and descriptions of numbers of elements.

Table 1. Cardinality
	Value
	Description

	1
	Exactly one of this element is required

	0..N
	This element is optional; up to and including N number of this element may be present

	0..*
	Optionally, many of this element may be present

	1..*
	At least one of this element is required, many may be present


2 Common Elements
The following subsections ​describe each of the metadata elements that are common among the various UMM profiles.

2.1 Related URL
Element Specification
RelatedURL (0..*)

RelatedURL/URL (1)

RelatedURL/Description (0..1)

RelatedURL/URLContentType (1) <CollectionURL, PublicationURL, DataCenterURL, DistributionURL, DataContactURL, VisualizationURL>

RelatedURL/Type (1) {Valid values shown below}

RelatedURL/Subtype (0..1) {Valid values shown below}

RelatedURL/GetData (0..1)

RelatedURL/GetData/Format (1) <ascii, binary, GRIB, BUFR, HDF4, HDF5, HDF-EOS4, HDF-EOS5, jpeg, png, tiff, geotiff, kml, Not provided>

RelatedURL/GetData/MimeType (0..1) {Valid values shown below}

RelatedURL/GetData/Size (1)

RelatedURL/GetData/Unit (1) <KB, MB, GB, TB, PB>

RelatedURL/GetData/Fees (0..1)

RelatedURL/GetData/Checksum (0..1)

RelatedURL/GetService (0..1)

RelatedURL/GetService/Format (0..1) <ascii, binary, GRIB, BUFR, HDF4, HDF5, HDF-EOS4, HDF-EOS5, jpeg, png, tiff, geotiff, kml, Not provided>

RelatedURL/GetService/MimeType (1) {Valid values shown below}

RelatedURL/GetService/Protocol (1) <ESI, FTP, FTPS, HTTP, HTTPS, OPeNDAP, WCS, WMS, Not provided>

RelatedURL/GetService/FullName (1)

RelatedURL/GetService/DataID (1)

RelatedURL/GetService/DataType (1)

RelatedURL/GetService/URI (0..*)

 

Valid Values for

· URLContentType 

· Type 

· Subtype

 

	· DistributionURL 

· DOWNLOAD SOFTWARE 

·  

· MOBILE APP

· GET DATA 

·  

· APPEARS

· DATA COLLECTION BUNDLE

· DATA TREE

· DATACAST URL

· DIRECT DOWNLOAD

· Earthdata Search

· EOSDIS DATA POOL

· GIOVANNI

· GoLIVE Portal

· IceBridge Portal

· LAADS

· LANCE

· MIRADOR

· MODAPS

· NOAA CLASS

· NOMADS

· Order

· PORTAL

· Subscribe

· USGS EARTH EXPLORER

· VERTEX

· VIRTUAL COLLECTION

· GOTO WEB TOOL 

·  

· LIVE ACCESS SERVER (LAS)

· MAP VIEWER

· SIMPLE SUBSET WIZARD (SSW)

· SUBSETTER

· USE SERVICE API 

·  

· GRADS DATA SERVER (GDS)

· MAP SERVICE

· OPENDAP DATA

· OpenSearch

· SERVICE CHAINING

· TABULAR DATA STREAM (TDS)

· THREDDS DATA

· WEB COVERAGE SERVICE (WCS)

· WEB FEATURE SERVICE (WFS)

· WEB MAP SERVICE (WMS)

· WEB MAP TILE SERVICE (WMTS)

· VisualizationURL 

· GET RELATED VISUALIZATION 

·  

· WORLDVIEW

· GIOVANNI

· MAP
	· CollectionURL 

· DATA SET LANDING PAGE 

·  

· EXTENDED METADATA 

·  

· PROFESSIONAL HOME PAGE 

·  

· PROJECT HOME PAGE 

·  

· PublicationURL 

· VIEW RELATED INFORMATION 

·  

· ALGORITHM DOCUMENTATION

· ALGORITHM THEORETICAL BASIS DOCUMENT (ATBD)

· ANOMALIES

· CASE STUDY

· DATA CITATION POLICY

· DATA QUALITY

· DATA RECIPE

· DELIVERABLES CHECKLIST

· GENERAL DOCUMENTATION

· HOW-TO

· IMPORTANT NOTICE

· INSTRUMENT/SENSOR CALIBRATION DOCUMENTATION

· MICRO ARTICLE

· PI DOCUMENTATION

· PROCESSING HISTORY

· PRODUCT HISTORY

· PRODUCT QUALITY ASSESSMENT

· PRODUCT USAGE

· PRODUCTION HISTORY

· PUBLICATIONS

· READ-ME

· REQUIREMENTS AND DESIGN

· SCIENCE DATA PRODUCT SOFTWARE DOCUMENTATION

· SCIENCE DATA PRODUCT VALIDATION

· USER FEEDBACK PAGE

· USER'S GUIDE

· DataCenterURL 

· HOME PAGE 

·  

· DataContactURL 

· HOME PAGE 

·  

	 
	 


 

Valid values for RelatedURL/GetService/MimeType:

	· application/json

· application/xml

· application/x-netcdf

· application/gml+xml

· application/vnd.google-earch.kml+xml

· image/gif

· image/tiff

· image/bmp

· text/csv

· text/xml
	· application/pdf

· application/x-hdf

· application/xhdf5

· application/octet-stream

· application/vnd.google-earth.kmz

· image/jpeg

· image/png

· image/vnd.collada+xml

· text/html

· text/plain


 

Description
This element describes any resource-related URLs that include project home pages, resource information pages, services, related data, archives/servers, metadata extensions, direct links to online software packages, web mapping services, links to images, documents, or other data. When filling out this element URLContentType and Type are required - Description and Subtype are optional. If the URLContentType is "DistributionURL" and the Type is "GET DATA", "DOWNLOAD SOFTWARE", or "GOTO WEB TOOL", then the RelatedURL/GetData sub-elements are also filled out. If the URLContentType is "DistributionURL" and the Type is "USE SERVICE API", then the RelatedURL/GetService sub-elements are also filled out.

 

•    RelatedURL - contains URLs to data or services (e.g. Distribution URLs).

•    GetData - information about the data (e.g. format, size, units, fees, checksum).

•    GetService - contains Universal Resource Identifiers (URI)s to data via services and information about the data and service (e.g. mime type, protocol, name, data IDs, data type).

 

Some use Examples:

I have a DAAC Home page that I would like to put into the metadata:

RelatedURL/URL = http://www.daachomepage.gov

RelatedURL/Description = The DAAC home page

RelatedURL/URLContentType = DataCenterURL

RelatedURL/Type = HOME PAGE

RelatedURL/Subtype =

 

I have a file that I can distribute to whomever is interested:

RelatedURL/URL = http://www.daachomepage.gov/path/downloadable.doc

RelatedURL/Description = some downloadable resource

RelatedURL/URLContentType = DistributionURL

RelatedURL/Type = GET DATA

RelatedURL/Subtype = DATA TREE
RelatedURL/GetData/Format = application/msword

RelatedURL/GetData/Size = 40

RelatedURL/GetData/Unit = MB

RelatedURL/GetData/Fees = 0

RelatedURL/GetData/Checksum = f5d30a4f2

 

Profile Utilization
Collection

 

Cardinality
0..*

 

Mapping
DIF 9:

/DIF/Related_URL

/DIF/Multimedia_Sample

/DIF/Distribution

 

DIF 10:

/DIF/Related_URL

/DIF/Multimedia_Sample

/DIF/Distribution

 

ECHO 10 Collection:

/Collection/OnlineAccessURLs/OnlineAccessURL

/Collection/AssociatedBrowseImageUrls

/Collection/OnlineResources

/Collection/Price

/Collection/DataFormat

 

ISO 19115-2:

/gmi:MI_Metadata/gmd:distributionInfo/gmd:MD_Distribution/gmd:distributor/gmd:MD_Distributor/gmd:distributorTransferOptions/gmd:MD_DigitalTransferOptions/gmd:onLine/gmd:CI_OnlineResource

and/or

/gmi:MI_Metadata/gmd:identificationInfo/gmd:MD_DataIdentification/gmd:graphicOverview/gmd:MD_BrowseGraphic/gmd:fileName/gmx:FileName src=

 

Examples
DIF 9:

   <Related_URL>

      <URL_Content_Type uuid="6e72d128-7d28-4bd0-bac0-8c5ffd8b31f1">

     <Type>VIEW PROJECT HOME PAGE</Type>

      </URL_Content_Type>

      <URL>http://www.waisdivide.unh.edu/</URL>

   </Related_URL>

   <Related_URL>

      <URL_Content_Type uuid="5ec1bb9d-0efc-4099-9b31-ec791bbd8145">

     <Type>VIEW RELATED INFORMATION</Type>

      </URL_Content_Type>

      <URL>http://www.homepage.montana.edu/~lkbonney/</URL>

      <Description>

         Website for the Priscu Research Group

      </Description>

   </Related_URL>

 

<Multimedia_Sample>

   <URL>http://www.waisdivide.unh.edu/images/sitemap1_large.jpg</URL>/p>

   </Multimedia_Sample>

 

DIF 10:

    <Multimedia_Sample>
        <URL>http://disc.gsfc.nasa.gov/AIRS/images/G1932015.04.19allL1CBrightnessTemperature_K_at10.9microns_map.png</URL>
        <Format>PNG</Format>
        <Caption>The BT derived from an AIRS Level 1C granule for a channel at 10.9 microns.</Caption>
        <Description>Sample image of an AIRICRAD channel converted to brighness temperature</Description>
    </Multimedia_Sample>

    <Related_URL>
        <URL_Content_Type>
            <Type>GET DATA</Type>
            <Subtype>DATA TREE</Subtype>
        </URL_Content_Type>
        <URL>http://airsl1.gesdisc.eosdis.nasa.gov/data/Aqua_AIRS_Level1/AIRICRAD.006/</URL>
        <Description>Access the data via HTTP.</Description>
    </Related_URL>
    <Related_URL>
        <URL_Content_Type>
            <Type>GET DATA</Type>
            <Subtype>MIRADOR</Subtype>
        </URL_Content_Type>
        <URL>http://mirador.gsfc.nasa.gov/cgi-bin/mirador/homepageAlt.pl?keyword=AIRICRAD</URL>
        <Description>Mirador is a data search interface that allows searching, browsing, and retrieving of Earth science data archived at NASA GES DISC.</Description>
    </Related_URL>
    <Related_URL>
        <URL_Content_Type>
            <Type>GET DATA</Type>
        </URL_Content_Type>
        <URL>http://airsl1.gesdisc.eosdis.nasa.gov/opendap/Aqua_AIRS_Level1/AIRICRAD.006/contents.html</URL>
        <Description>Access the data via the OPeNDAP protocol.</Description>
    </Related_URL>
...
    <Related_URL>
        <URL_Content_Type>
            <Type>GET DATA</Type>
            <Subtype>EARTHDATA SEARCH</Subtype>
        </URL_Content_Type>
        <URL>https://search.earthdata.nasa.gov/search?q=AIRICRAD+006</URL>
        <Description>Use the Earthdata Search Client (EDSC) to find and retrieve data sets across multiple data centers.</Description>
    </Related_URL>
...

 

ECHO 10 Collection:

<OnlineAccessURLs>

   <OnlineAccessURL>

      <URL>http://sedac.ciesin.columbia.edu/data/set/ulandsat-cities-from-space/data-download</URL>

      <URLDescription>data download page</URLDescription>

   </OnlineAccessURL>

</OnlineAccessURLs>

<OnlineResources>

   <OnlineResource>

      <URL>http://dx.doi.org/10.7927/H4SQ8XB1</URL>

      <Description>data set DOI and homepage</Description> 

      <Type>DOI URL</Type>

   </OnlineResource>

</OnlineResources>

 

<AssociatedBrowseImageUrls>

    <ProviderBrowseUrl>

        <URL>http://sedac.ciesin.columbia.edu/data/set/ulandsat-cities-from-space/maps</URL>

    </ProviderBrowseUrl>

</AssociatedBrowseImageUrls>

 

ISO 19115-2:

<gmd:onLine>

      <gmd:CI_OnlineResource>

         <gmd:linkage>

            <gmd:URL>http://sedac.ciesin.columbia.edu/data/set/ulandsat-cities-from-space/data-download</gmd:URL>

         </gmd:linkage>

         <gmd:applicationProfile gco:nilReason="missing"/>

         <gmd:description>

            <gco:CharacterString>data download page</gco:CharacterString>

         </gmd:description>

         <gmd:function>

            <gmd:CI_OnLineFunctionCode codeList="http://www.isotc211.org/2005/resources/Codelist/gmxCodelists.xml#CI_OnLineFunctionCode" codeListValue="download">download</gmd:CI_OnLineFunctionCode>

         </gmd:function>

      </gmd:CI_OnlineResource>

   </gmd:onLine>

   <gmd:onLine>

      <gmd:CI_OnlineResource>

         <gmd:linkage>

            <gmd:URL>http://dx.doi.org/10.7927/H4SQ8XB1</gmd:URL>

         </gmd:linkage>

         <gmd:applicationProfile gco:nilReason="missing"/>

         <gmd:name>

            <gco:CharacterString>DOI URL</gco:CharacterString>

         </gmd:name>

         <gmd:description>

            <gco:CharacterString>data set DOI and homepage</gco:CharacterString>

         </gmd:description>

         <gmd:function>

            <gmd:CI_OnLineFunctionCode codeList="http://www.isotc211.org/2005/resources/Codelist/gmxCodelists.xml#CI_OnLineFunctionCode" codeListValue=""/>

         </gmd:function>

      </gmd:CI_OnlineResource>

   </gmd:onLine>

...

<gmd:graphicOverview>

  <gmd:MD_BrowseGraphic>

     <gmd:fileName>

        <gmx:FileName src="http://sedac.ciesin.columbia.edu/data/set/ulandsat-cities-from-space/maps"/>

     </gmd:fileName>

     <gmd:fileDescription>

        <gco:CharacterString>File Size:</gco:CharacterString>

     </gmd:fileDescription>

     <gmd:fileType gco:nilReason="missing"/>

  </gmd:MD_BrowseGraphic>

2.2 Online Resource
Element Specification
OnlineResource/ (0..1)

OnlineResource/Linkage (1)

OnlineResource/Protocol (0..1)

OnlineResource/ApplicationProfile (0..1)

OnlineResource/Name (0..1)

OnlineResource/Description (0..1)

OnlineResource/Function (0..1)

OnlineResource/MimeType (0..1) {Look at RelatedURL MimeType values}

 

Description
This element describes any online resource which includes citations, publications or references. This element is analogous to CI_Online_Resource from EN ISO 19115-1:2014 Geographic Information – Metadata – Part 1: Fundamentals. This element is not a base element but will be included as a sub-element of resource citation and publication reference. Any mapping to the OnlineResource sub-element will be accomplished through the main element, therefore the mapping section is omitted.

2.3 Use Constraints
Element Specification
UseConstraints

 

Description
The UseConstraints element is designed to protect privacy and/or intellectual property by allowing the author to specify how the visualization may or may not be used after access is granted. This includes any special restrictions, legal prerequisites, terms and conditions, and/or limitations on using the item. Providers may request acknowledgement of the item from users and claim no responsibility for quality and completeness. UseConstraints describes how the item may be used once access has been granted; and is distinct from AccessConstraints, which refers to any constraints in accessing the item.

 

Profile Utilization
Visualization

 

Cardinality
0..1

 

Analysis
This element's value is an uncontrolled block of text describing the use constraint.

 

Mapping
DIF 9:

/DIF/Use_Constraints

 

DIF 10:

/DIF/Use_Constraints

 

ISO 19115-2:

/gmd:MD_Metadata/gmd:identificationInfo/gmd:MD_DataIdentification/gmd:resourceConstraints/gmd:MD_LegalConstraints/gmd:useLimitation/gco:CharacterString

 

 

Examples
DIF 9:

<Use_Constraints>This data set conforms to the PICCCBY Attribution License
(http://creativecommons.org/licenses/by/3.0/).

Please follow instructions listed in the citation reference provided at http://data.aad.gov.au/aadc/metadata/citation.cfm?entry_id=ASAC_2201_HCL_0.5 when using these data.</Use_Constraints>

 

DIF 10:

<Use_Constraints>The distribution of this data set is funded by NASA's Earth Science Enterprise (ESE). The data are not copyrighted; however, we request that when you publish data or results using these data, please acknowledge as follows:
                                                
The data used in this study were acquired as part of the Tropical Rainfall Measuring Mission (TRMM). The algorithms were developed by the TRMM Science Team. The data were processed by the TRMM Science Data and Information System (TSDIS) and the TRMM Office; they are archived and distributed by the Goddard Earth Sciences Data and Information Services Center. TRMM is an international project jointly sponsored by the Japan National Space Development Agency (NASDA) and the U.S. National Aeronautics and Space Administration (NASA) Office of Earth Sciences.
                                                
Please send a copy of your publication to Help Desk, Goddard Earth Sciences Data and Information Services Center, Code 610.2, NASA GSFC, Greenbelt, MD 20771 or email the reference of your publication to gsfc-help-disc@lists.nasa.gov.</Use_Constraints>

 

ISO 19115-2:

      <gmd:resourceConstraints>
        <gmd:MD_LegalConstraints>
          <gmd:useLimitation>
            <gco:CharacterString>The distribution of this data set is funded by NASA's Earth Science Enterprise (ESE). The data are not copyrighted; however, we request that when you publish data or results using these data, please acknowledge as follows:

The data used in this study were acquired as part of the Tropical Rainfall Measuring Mission (TRMM). The algorithms were developed by the TRMM Science Team. The data were processed by the TRMM Science Data and Information System (TSDIS) and the TRMM Office; they are archived and distributed by the Goddard Earth Sciences Data and Information Services Center. TRMM is an international project jointly sponsored by the Japan National Space Development Agency (NASDA) and the U.S. National Aeronautics and Space Administration (NASA) Office of Earth Sciences.

Please send a copy of your publication to Help Desk, Goddard Earth Sciences Data and Information Services Center, Code 610.2, NASA GSFC, Greenbelt, MD 20771 or email the reference of your publication to gsfc-help-disc@lists.nasa.gov.</gco:CharacterString>
          </gmd:useLimitation>
           ...
        </gmd:MD_LegalConstraints>
      </gmd:resourceConstraints>

2.4 Access Constraints
Element Specification
AccessConstraints/Description   (1)
AccessConstraints/Value   (0..1)

 

Description
The Description sub-element allows the author to provide information concerning accessing constraints. This includes any special restrictions, legal prerequisites, limitations and/or warnings on obtaining the data. Examples of values include: Public, In-house, Limited, and None. The Value sub-element is used for special access control list (ACL) rules (http://en.wikipedia.org/wiki/Access_control_list) - for example, to hide metadata when it isn't ready for public consumption. Providers use the AccessConstraint/Value element to specify various restriction levels with ACLs. For example: A provider might specify a service Level ACL that hides all items (collections for this example) with a value element set to "15.0". There is no controlled mapping for what the values represent.

 

Profile Utilization
Collection, Granule

 

Cardinality
0..1

 

Mapping
DIF 9:

/DIF/Access_Constraints

/DIF/Extended_Metadata/Metadata

 

DIF 10:

/DIF/Access_Constraints

/DIF/Extended_Metadata/Metadata

 

ECHO 10 Collection:

/Collection/RestrictionComment

/Collection/RestrictionFlag

 

ECHO 10 Granule:

/Granule/RestrictionComment

/Granule/RestrictionFlag

 

ISO 19115-2:

/gmi:MI_Metadata/gmd:identificationInfo/gmd:MD_DataIdentification/gmd:resourceConstraints/gmd:MD_LegalConstraints/gmd:useLimitation/gco:CharacterString (prefix: 'Restriction Comment:' )

/gmi:MI_Metadata/gmd:identificationInfo/gmd:MD_DataIdentification/gmd:resourceConstraints/gmd:MD_LegalConstraints/gmd:otherConstraints/gco:CharacterString (prefix: 'Restriction Flag:' )

 

Examples
DIF 9:

<Access_Constraints>None</Access_Constraints>

 

<Extended_Metadata>
  <Metadata>
    <Group>gov.nasa.earthdata.cmr</Group>
    <Name>Restriction</Name>
    <Value>[0 or 1+]</Value>
  </Metadata>
</Extended_Metadata>

 

DIF 10:

<Access_Constraints>None.  The paper is open access.</Access_Constraints>

 

<Extended_Metadata>
  <Metadata>
    <Group>gov.nasa.earthdata.cmr</Group>
    <Name>Restriction</Name>
    <Value>[0 or 1+]</Value>
  </Metadata>
</Extended_Metadata>

 

ECHO 10 Collection:

<RestrictionFlag>0</RestrictionFlag>

<RestrictionComment>None</RestrictionComment>

 

ECHO 10 Granule:

<RestrictionFlag>0</RestrictionFlag>

<RestrictionComment>

      This product has full public access

 </RestrictionComment>

 

ISO 19115-2

<gmd:resourceConstraints>

    <gmd:MD_LegalConstraints>

       <gmd:useLimitation>

          <gco:CharacterString>Restriction Comment: There are no fees for training, materials, rubrics, and assessments. Each

   participant must complete the online form  to access materials.</gco:CharacterString>

       </gmd:useLimitation>

       <gmd:otherConstraints>

          <gco:CharacterString>Restriction Flag:0</gco:CharacterString>

       </gmd:otherConstraints>

    </gmd:MD_LegalConstraints>

</gmd:resourceConstraints>

2.5 Science Keywords
Element Specification
ScienceKeywords/Category   (1)
ScienceKeywords/Topic   (1)
ScienceKeywords/Term   (1)
ScienceKeywords/VariableLevel1   (0..1)
ScienceKeywords/VariableLevel2   (0..1)
ScienceKeywords/VariableLevel3   (0..1)
ScienceKeywords/DetailedVariable   (0..1)

 

Description
This element enables specification of Earth Science keywords. All of the sub-elements except for DetailedVariable are controlled and use the GCMD Science Keyword vocabulary.  The vocabulary is managed by the KMS and it can be found at this location: http://gcmdservices.gsfc.nasa.gov/static/kms/sciencekeywords/sciencekeywords.csv. The DetailedVariable is an uncontrolled free text element that allows the metadata author to include another keyword to more fully describe the data.

 

Profile Utilization
Collection, Service

 

Cardinality
1..*

 

Mapping
DIF 9:

/DIF/Parameters/

 

DIF 10:

/DIF/Science_Keywords/

 

ECHO 10 Collection:

/Collection/ScienceKeywords/ScienceKeyword/

 

ISO 19115-2:

/gmi:MI_Metadata/gmd:identificationInfo/gmd:MD_DataIdentification/gmd:descriptiveKeywords/gmd:MD_Keywords/gmd:keyword/gco:CharacterString

with

/gmi:MI_Metadata/gmd:identificationInfo/gmd:MD_DataIdentification/gmd:descriptiveKeywords/gmd:MD_Keywords/gmd:keyword/gmd:type/MD_KeywordTypeCode[@codeListValue="theme"]

 

Examples
DIF 9:

  <Parameters>
    <Category>EARTH SCIENCE</Category>
    <Topic>BIOSPHERE</Topic>
    <Term>ECOLOGICAL DYNAMICS</Term>
    <Variable_Level_1>ECOTOXICOLOGY</Variable_Level_1>
    <Variable_Level_2>SPECIES BIOACCUMULATION</Variable_Level_2>
  </Parameters>

 

DIF 10:

<Science_Keywords>
    <Category>EARTH SCIENCE</Category>
    <Topic>ATMOSPHERE</Topic>
    <Term>ATMOSPHERIC CHEMISTRY</Term>
    <Variable_Level_1>CARBON AND HYDROCARBON COMPOUNDS</Variable_Level_1>
    <Variable_Level_2>CARBON DIOXIDE</Variable_Level_2>
</Science_Keywords>

 

ECHO 10 Collection:

<ScienceKeywords>

  <ScienceKeyword>

   <CategoryKeyword>EARTH SCIENCE</CategoryKeyword>

   <TopicKeyword>HYDROSPHERE</TopicKeyword>

   <TermKeyword>SURFACE WATER</TermKeyword>

   <VariableLevel1Keyword>

    <Value>DISCHARGE/FLOW</Value>

   </VariableLevel1Keyword>

  </ScienceKeyword>

  <ScienceKeyword>

   <CategoryKeyword>EARTH SCIENCE</CategoryKeyword>

   <TopicKeyword>HYDROSPHERE</TopicKeyword>

   <TermKeyword>SURFACE WATER</TermKeyword>

   <VariableLevel1Keyword>

    <Value>STAGE HEIGHT</Value>

   </VariableLevel1Keyword>

  </ScienceKeyword>

</ScienceKeywords>

 

ISO 19115-2:

<gmd:descriptiveKeywords>

            <gmd:MD_Keywords>

               <gmd:keyword>

                  <gco:CharacterString>EARTH SCIENCE&gt;HYDROSPHERE&gt;SURFACE WATER&gt;DISCHARGE/FLOW&gt;NONE&gt;NONE&gt;NONE</gco:CharacterString>

               </gmd:keyword>

               <gmd:keyword>

                  <gco:CharacterString>EARTH SCIENCE&gt;HYDROSPHERE&gt;SURFACE WATER&gt;STAGE HEIGHT&gt;NONE&gt;NONE&gt;NONE</gco:CharacterString>

               </gmd:keyword>

               <gmd:type>

                  <gmd:MD_KeywordTypeCode codeList="http://www.isotc211.org/2005/resources/Codelist/gmxCodelists.xml#MD_KeywordTypeCode"

                                          codeListValue="theme">theme</gmd:MD_KeywordTypeCode>

               </gmd:type>

               <gmd:thesaurusName>

                  <gmd:CI_Citation>

                     <gmd:title>

                        <gco:CharacterString>NASA/GCMD Science Keywords</gco:CharacterString>

                     </gmd:title>

                        ...                     

                 </gmd:CI_Citation>

               </gmd:thesaurusName>

            </gmd:MD_Keywords>

         </gmd:descriptiveKeywords>

Appendix A Abbreviations and Acronyms
	ACL
	Access Control List

	CMR
	Common Metadata Repository

	DAAC
	Distributed Active Archive Center

	DIF
	Directory Interchange Format

	ECHO
	Earth Observing System (EOS) Clearing House

	EOS
	Earth Observing System

	EOSDIS
	Earth Observing System Data and Information System

	ESDIS
	Earth Science Data and Information System

	GCMD
	Global Change Master Directory

	ISO
	International Organization for Standardization

	KMS
	Keyword Management System

	MAS
	Metadata Architecture Studies

	MENDS
	Metadata Evolution for NASA Data Systems

	NASA
	National Aeronautics and Space Administration

	UMM
	Unified Metadata Model

	UMM-C
	Unified Metadata Model - Collections

	UMM-Common
	Unified Metadata Model - Common Elements

	UMM-G
	Unified Metadata Model - Granules

	UMM-S
	Unified Metadata Model - Services

	UMM-Var
	Unified Metadata Model - Variables

	UMM-Vis
	Unified Metadata Model - Visualization

	URI
	Uniform Resource Identifier

	URL
	Uniform Resource Locator

	XML
	Extensible Markup Language

	XPath
	XML Path Language


GSFC ESDIS CMO
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